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1 MICROSOFT WORD

Introduction

Accessibility in documents is essential to ensure that all individuals, regardless 
of their visual abilities, can access information equitably. This guide provides 
recommendations and detailed steps for creating accessible documents in Microsoft 
Word.

General Requirements

Document format

When saving a document in Word, you should ensure that the most modern format 
(.docx) is used, as this guarantees compatibility with screen readers, in addition to 
other built-in features that are lost with earlier formats (.doc) or other formats (.rtf).

This should be verified especially when processing old documents or documents 
from external sources.

Document structure

When creating a document, you should consider how best to make the content 
legible and easy to understand. It is therefore necessary to pay attention to the 
correct use of headings, subheadings and lists. It is recommended to use these 
elements to facilitate reading, avoiding using them solely for aesthetic or visual layout 
purposes.

Content organisation

The first step in correctly structuring the content of a document is assigning styles.
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1 To apply a style to text in Microsoft Word:

1. Select the text to which you wish to apply a style.
2. Go to the Home tab on the ribbon.
3. In the Styles group, select the desired style (for example, Heading 1, Heading 2,

Normal).

Using styles

• The Heading 1 style should be used for the main title of the document. Typically,
there is only one text with this style in a document.

• The Heading 2 style should be used for subtitles or main sections.
• The Heading 3 style should be used for subsections within a main section.
• The Normal style should be used for body text.

Unless they are absolutely necessary, headings below level 3 are not usually 
advisable, as by that point the user will most likely have lost track of the document 
structure.

TIP

To quickly apply a heading style to text that has already been written, simply place 
the cursor on that text and press Alt + Shift + Right or Left arrow to switch between 
heading styles one level at a time.



Creating accessible documentation

7

1 Additional structuring

If you need to further structure content within a level 3 heading, it is recommended 
to use numbered or bulleted lists to maintain the clarity and organisation of the 
document.

Creating Accessible Lists

Lists are used to organise content without using styles.

To create a list in Microsoft Word, you need to understand how this format works. It 
can be applied to text that has already been written, or you can select the format and 
then start writing.

If applied to existing text, each paragraph break in the selected text will generate a 
new list item. If you select the format and then write, likewise, each paragraph break 
(pressing Enter while writing) will generate a new list item.

To end the list, press the Enter key twice to return to the Normal style.

To select the type of list, go to the Home tab on the ribbon. In the Paragraph group, 
select the desired list type (numbered or bulleted) and, in the drop-down menu that 
appears, choose the appearance you want for the list.
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1 Numbered List

For numbered lists, you can select the number format (followed by a bracket, a full 
stop, Roman numerals or letters). The result will display the chosen appearance.

1. Step one
2. Step two
3. Step three

Bulleted List

For bulleted lists, you should choose the type of bullet (dots, squares, arrows, etc.) 
WARNING: the use of hollow circle bullets is not recommended, as users with low 
vision may find them too similar to the letter “o”. The result will show the chosen 
bullet:

• Item one
• Item two
• Item three

Typography

The choice of typeface is an important requirement for users with low vision. Some 
fonts are designed to imitate handwriting or Gothic lettering and may be aesthetically 
pleasing in certain contexts. However, for people with low vision, these fonts have a 
very low level of legibility.

Therefore, when drafting documents, you need to pay attention to the following 
aspects:

• Selection of clear and legible fonts (sans-serif).
• Adequate font size (minimum 12 points).
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1 Sans-serif fonts

Sans-serif fonts do not have decorative strokes on the letters, although these are not 
necessarily elaborate features. In many typefaces, they are simply the small extensions 
found at the ends of letters.

Three of the most common, and therefore most widely used, sans-serif fonts are Arial, 
Tahoma and Verdana.

If you prefer not to rely on these font names but still want to check whether a font is 
suitable, look at the lowercase letters “i” and “l”. If they appear as simple straight lines 
(with a dot above the “i”), the font can generally be considered suitable.

Below, we can see both letters, the first in one of the best-known “serif” fonts, Times 
New Roman, followed by one of the fonts we recommend, Arial. The differences are 
obvious.

TIP

To quickly access the dialogue box that lets you change all the properties of the 
selected text (not just the font type, size or colour, but also some more advanced 
options such as double underlines, strikethrough, superscript, subscript, etc.), press 
Ctrl + Shift + M.
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1 Contrast and Colour

Using colour in document text, which is very common, can create accessibility issues 
for users with visual impairments.

Colour may be used to improve the appearance of a document, but it is also often 
used to highlight certain parts of the text.

Both uses are acceptable, provided the following criteria are observed:

• Make sure there is a high contrast between the text and the background, so that
colours do not make the text harder to read.

• If colour is used to highlight content, the same emphasis should also be conveyed
in ways that do not rely on colour alone.

Choosing the text colour

In principle, and unless a particular effect is intended (a topic that will be addressed 
below), it is preferable to always set the font to “Automatic” colour. This means that 
the screen will display according to the colour settings selected in Windows, usually 
black in the standard configuration and white in high contrast.

Additionally, you should verify that the background is set to “No Colour”.

Both values are changed on the Home ribbon, using the “Font Colour” button in the 
Font group and “Shading” in the Paragraph group.
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1 Highlighting with colours

But what if you want to use colours, for example, to highlight important content?

Poor contrast can be a problem for people with low vision, particularly when their 
condition affects  colour perception, so it is important to check that the text colour 
provides sufficient contrast against the background. It is also worth remembering that 
appearance alone can be misleading. What looks like enough contrast at first glance 
may not in fact be sufficient for people with certain visual impairments.

Free online tools are available that can verify whether the contrast used is correct.

That said, if the use of colours is not purely aesthetic but is being used to highlight 
content, it is preferable to provide an additional alternative for those users who 
cannot see the colours or who use a screen reader.

One approach is to add text indicating that particular feature, such as:

IMPORTANT

The use of colours in text should be done bearing in mind the need for universal 
access to information.
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1 Setting the text language

When writing a Word document, the language you are writing in is obvious. But Word 
doesn’t know.

Word—and Office generally—will normally be installed with Spanish as the default 
language, and will therefore assume that this is the language normally used. 
However, text in other languages may sometimes be included, sometimes without 
the user even realising it. This has implications both for the use of the word processor 
itself and for accessibility.

How can other languages be used unknowingly? Primarily when using text from 
external sources via copy and paste. This is far more common than it might seem. 
Such text may come, for example, from websites whose default language is different, 
even if the content is displayed in translation, or from Word documents or emails 
created on systems where Office is configured in another language.

But why is it important to correctly define the language if the text reads correctly?

Firstly, for spelling purposes. If spell check is enabled while you type, failing to set the 
correct language will cause the text to be flagged with spelling errors, because the 
spelling rules for one language will be applied to text written in another.

Accessibility will also be affected, as screen readers automatically switch the 
language of the voice synthesiser according to the language Word has assigned to 
the text. As a result, if a text written in Spanish is tagged as English, the screen reader 
will use English pronunciation rules and accent patterns.
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1 To define the language of a text once it has been written:

1. Select the text.
2. On the Review ribbon, click the Language button and in the drop-down menu,

click Set Proofing Language.
3. In the dialogue box that opens, select the language for the text.
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1 Using tables

Tables should be kept as simple as possible, avoiding layouts in which the number or 
size of cells changes from one row or column to the next. For example, a single cell in 
one row should not become three separate cells in the next.

To achieve this, it is advisable to use the Table Grid style as the standard table format.

Once a table has been inserted, place the cursor anywhere inside it to display the 
Table Design tab in Word. You can then choose the required style from the Table 
Styles gallery.

It is also important to identify the header row clearly. To do this, select the Header 
Row option on the same tab, in the Table Style Options group.
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1 Since tables are intended to present data arranged in rows and columns, they should 
not be used purely for document layout. The appropriate alternative will depend on 
whether the layout in question involves multiple columns or just one.

Where a single row is split into two columns, it is preferable to use tab stops, as they 
are easier to manage. Where a table consists of just one row and one column, it is 
clear that it is being used only to enclose the text within cell borders. In such cases, 
paragraph borders can be used instead, as the visual result is virtually the same.

Using images

Images can be included in documents without this posing an obstacle to accessibility.

In any case, the image must have alt text. This text should be descriptive but not 
exhaustive, avoiding descriptions that are too long or that go into unnecessary detail 
that does not provide relevant information.

Additionally, you should avoid indicating the type of object. That is, it is not necessary 
to include in the alt text expressions such as “Image of...” or “Photo of...”, since screen 
readers themselves usually indicate that a graphic object is being described (the 
exception to this is if what is being described is a screenshot, in which case it is 
appropriate to specify this, as shown in the example).
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1 To add alt text to an image:

1. Select the image and right-click or press the Applications key.
2. In the context menu (right-click, Shift + F10 or the Applications key),

select Format Picture.
3. In the format pane, click View Alt Text.
4. In the Alt Text pane, enter a description in the Description field.

EXAMPLE

If the document contains a bar chart showing a company’s quarterly sales.  
The following can be included as alt text: “Bar chart showing the growth in quarterly 
sales in the first, second and third quarters of the year.”

IMPORTANT

If the purpose of the image is to describe a process, a textual description of that 
process should be provided in the body of the document, detailing the name and 
type of the objects shown in the image, as well as all the steps required to carry out 
the process using the keyboard.

Links

In a Word document, links are commonly used to allow the end user to access other 
content (which may be web content, other files or even email addresses).

In terms of accessibility, a very common error to avoid is the typical Click here links. 
This is because, when taken out of context, such links do not give the user any 
meaningful information. Screen reader users may choose to navigate through a 
document by moving only from link to link.
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1 In that case, links of this kind tell them nothing. It is also quite common for the same 
document to contain several instances of Click here, leaving the user with no way of 
knowing which one leads where.

To create an accessible link, it is preferable to use an identifiable fragment of the text 
itself.

For example, in a user guide you want to direct the reader to a web page containing 
help on a procedure. In that case, you can write a description such “you will find 
more information on the app’s help page”, where help page is a link that leads to the 
desired address.

To create a link in this way:

1. Select the text that will serve as the link.
2. Open the context menu (right-click, Shift + F10 or the Applications key).
3. Click the Link option.
4. In the dialogue box, go to the Address field.
5. Enter the path the link will point to (or you can paste it if you have previously

copied it from the browser).
6. Click OK.

In this dialogue box, you can create an email link or a link to a document. There is also 
a Text to display field showing the selected text, which can be edited to make the link 
more informative for screen reader users.

This helps ensure that the link is accessible.
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1 Creating tables of contents

In Word, the usual way to create what is generally understood as an index is to use a 
Table of Contents.

For the table of contents to be useful, it should not go beyond three levels, and for 
screen reader users to read it properly, dot leaders should be used between the 
heading text and the page number.

It is not advisable to omit fill characters, since if the title of any chapter ends with 
a number, the page number will be read aloud by the screen reader immediately 
afterwards, making it difficult to understand.

When inserting it, you should tick the option to use hyperlinks instead of page 
numbers. This does not remove the page number; rather, it ensures that clicking on 
any part of the table of contents entry, and not just the page number, will navigate to 
the selected location in the document.

To create an accessible table of contents, follow these steps:

1. Select the location by placing the cursor where you want to insert the table of
contents (usually at the beginning of the document).

2. Go to the References tab on the ribbon.
3. Click the Table of Contents button in the Table of Contents group.
4. Select the Custom Table of Contents style.
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1 The Table of Contents dialogue box opens, allowing you to configure how the table 
will look.

1. Tick the Show page numbers and Right align page numbers checkboxes.
2. For Tab leader, choose “points”.
3. Tick the Use hyperlinks instead of page numbers checkbox.
4. Check that Show levels is set to 3.
5. Click OK.
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2 MICROSOFT OUTLOOK

Introduction

Accessibility in emails is crucial to ensure that all individuals, regardless of their visual 
abilities, can access information equitably. This guide provides recommendations and 
detailed steps for creating accessible emails in Microsoft Outlook.

Font format

Since Outlook is, in practice, a word-processing environment in which messages are 
written and sent to other users, the same principles already covered for Microsoft 
Word should be applied, with a few additional precautions.

The typeface should be a sans-serif font (Arial, Tahoma, Verdana or similar) and in a 
size no smaller than 12 points.

To select the font type and size in a message:

1. Go to the Message tab on the ribbon.
2. In the Basic Text group, select the font (Arial, Verdana...).
3. In the same group, select the desired font size from the corresponding

drop-down menu.
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2 This step will change the font in each new message. However, it is preferable to 
configure Outlook so that every new message uses an accessible font by default.

1. In the main Outlook window, go to File and click Options.
2. In the Options dialogue box, go to the Mail category.
3. Click the Stationery and Fonts button.
4. In the new dialogue box that opens, there are three Font... buttons which

respectively allow you to change the font for new messages, for replies and
forwards, and for plain text messages. Each of these leads to a new dialogue box
for selecting all the characteristics of the typeface.
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2 Text contrast and colour

Once the size and type have been defined, the colour must be set, which as a general 
rule should be Automatic.

As in the previous section, the colour can be set for all messages, distinguishing 
between new messages and replies or forwards, although it is more likely that the text 
colour will be changed on a case-by-case basis in specific messages.

To change the text colour:

1. On the Message tab of the ribbon.
2. In the Basic Text group, select Font Colour.
3. Choose colours that provide a high contrast between the text and the

background.

IMPORTANT

You should always choose a colour that provides sufficient contrast with the 
background, and if the colour is not merely aesthetic but conveys content (for 
example, to particularly emphasise a statement in the message), the change of colour 
must be accompanied by a textual alternative for users who cannot see the colours or 
who use a screen reader.
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2 Styles

If required by the length or content of the email, the text should also be structured in 
an accessible way, using styles and numbered or bulleted lists.

To apply styles:

1. Select the text to which a style will be applied.
2. Go to the Format Text tab on the ribbon.
3. In the Styles group, select the desired style (for example, Heading 1, Heading 2,

Normal) (you can also switch between heading styles by pressing Alt + Shift +
Right or Left arrow on the selected text).

To create Numbered and Bulleted Lists:

1. Select the text.
2. Go to the Message tab on the ribbon.
3. In the Paragraph group, select the desired list type (numbered or bulleted).
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2 Images

Images are not especially common in emails. However, when one is included, it is 
most likely intended to support the content of the message. With this in mind, it is 
important to remember that an image must never be the only way of conveying 
information, so you should:

• Add alt text to the image that briefly describes it.
• Provide a textual description of the content or processes illustrated by the image.

To add Alt Text:

1. In the context menu of the image (right-click, Shift + F10 or the Applications key
with the image selected), select View Alt Text.

2. In the Alt Text pane, enter a description in the Description field.
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2 Links

To insert links in an email in an accessible manner, follow these steps:

1. Select the text you wish to convert into a link.
2. Open the context menu (right-click, Shift + F10 or the Applications key) and select

the “Link” option.
3. Enter the URL in the “Address” field.
4. Make sure the text shown in the “Text to display” field is descriptive, avoiding

expressions such as “click here” or “see more”.

It is important to bear in mind the accessibility of links, even if a “copy-paste” is 
performed from another source, such as a document or a web page.
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3 MICROSOFT EXCEL

Introduction

Excel is a highly comprehensive tool for the quantitative analysis of information which, 
when used properly, facilitates presentation and decision-making in the business 
environment. It is therefore essential that it is accessible to all.

This section addresses the key design considerations for making spreadsheets 
created in Excel accessible and manageable.

Format

As in the previous sections, font and colour selection should follow an accessibility 
criterion, which logically remains the same:

• Use of sans-serif fonts (Arial, Tahoma, Verdana and similar).
• Font size no smaller than 12.
• Automatic colour.

All three characteristics can be changed on the Home ribbon, using the Font,  
Font Size and Font Colour buttons.
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3 Data presentation

When designing a worksheet, the aim is usually to present information clearly, often 
by using colour and patterns of blank and completed cells to help users identify the 
most important information quickly.

Where worksheets need to be used with accessibility tools, the use of colour does 
not have to be ruled out, but care must be taken to ensure sufficient contrast. If in 
doubt, it is best to choose strongly contrasting light and dark colours and to avoid 
combinations that may be difficult to distinguish, particularly black, green and red. 
Nor is there any need to avoid using cell borders to highlight data in the table.

That said, these very useful features should not be ruled out. What matters is that they 
must not be the only means used, and they should be avoided only where they create 
difficulties for users of assistive technology.

Creating uniform tables

Table uniformity refers not only to how the data is presented, but also to its 
consistency within the sheet. A basic rule to bear in mind is to avoid including 
decorative empty cells.

In Excel, column widths and row heights can be adjusted to visually create spaces 
between data. Empty rows and columns are a clear obstacle for screen reader users, 
as they force them to search around the worksheet for information. Leaving the first 
rows and columns blank is particularly problematic, since users will generally begin 
by moving through the first column in search of content.
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3 To change the row height and width:

1. Go to the Home ribbon.
2. Click the Format button and expand it.
3. Click Row Height.
4. Enter the desired height.
5. Repeat the process but clicking the Column Width button.

Another indicator of a correctly formed table is the logical arrangement of data. This, 
although it may seem obvious, is not always the case.

Row and column headers should occupy the first rows and columns, trying as far as 
possible not to accumulate multiple header rows/columns (this is explained in more 
detail in the section on merging cells). It is equally important that totals appear in the 
last rows and columns, as the final element of the tables, sharing the same rows and 
columns.
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3 Merging cells

Merged cells are very common in spreadsheets, and in some cases they are almost 
essential.

They allow longer content to be displayed without making some columns 
disproportionately wide or causing newly entered data to hide content already in the 
sheet.

From an accessibility point of view, the use of merged cells should be kept to a 
minimum. In particular, they should generally be limited to headers that need to span 
more than one column.

To understand the accessibility issues they can create, it is essential to test the 
table by moving through it with the cursor. While merged cells may cause no visual 
difficulty, they can be particularly problematic for screen reader users. As explained 
above, the main accessibility issue arises when data is presented linearly and the 
logical structure of the table becomes unclear. A blind user tends to interpret the 
table like a chessboard, with a succession of rows and columns that facilitates 
navigation.

The inclusion of merged cells creates irregular cursor movement. When a column is 
headed by a cell merged across three or more cells, the way it behaves will depend 
on the direction in which the cursor moves, on whether the merged cell is preceded 
by unmerged cells, and on whether it is reached from columns to the left or right.
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3 Although this behaviour can be understood, it places an extra burden on screen 
reader users, who may have to explore the entire worksheet in order to follow the 
data logically.

In short, applying a few basic principles of data organisation and formatting can 
make the difference between a worksheet that is both accessible and usable, and one 
whose data may technically be accessible but is extremely difficult to use.

Sheet labelling

If more than one table is to be included in the sheet and it contains a significant 
amount of data, it is preferable for the workbook to have a separate, correctly named 
sheet for each table, so that users can tell what data each sheet contains without 
having to open it.

To enter a name for a sheet:

• Go to the sheet you wish to rename.
• Go to the “Home ribbon”.
• Click the “Format” button.
• In the drop-down menu, select the

“Rename Sheet” option.
• The focus will be placed on the tab with

the sheet name (which by default will be
something like “Sheet1”), already selected,
and you simply need to type the new
name and press “Enter”.

You can also do this with the mouse by 
double-clicking on the sheet name and 
renaming it.
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3 Accessible charts

To create a chart, first select the data you wish to represent. You should include the 
cells containing labels for the rows or columns so that chart titles, axes, legends, etc. 
are automatically generated.

Charts are inherently inaccessible to blind users. For users with some remaining 
vision, however, it is essential to ensure sufficient colour contrast and a size that 
makes the data easy to see clearly.

You should avoid making the chart the central focus of the workbook. Charts are a 
support to the workbook, so the focus of the workbook should be on the data. Charts 
do not have to be placed on the same worksheet as the data they are based on, and 
can instead be moved to a separate sheet. This not only prevents users of assistive 
technology from coming across the chart in the middle of the data, but also gives the 
chart more space, making it easier to read —which is, after all, its purpose. It is also 
easier to locate it on its own sheet within the workbook.

Once the chart has been inserted in the sheet, it can be moved to a new sheet.  
To do this:

1. Select the chart (if using a screen reader, locate the object with Ctrl + Shift + O).
2. In the context menu (right-click, Shift + F10 or the Applications key).
3. Select the Move Chart option.
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3 This can also be done from the ribbon:

1. Select the chart.
2. Go to the Chart Design ribbon (if this ribbon is not visible, the chart has not been

correctly selected).
3. Click the Move Chart button.

A dialogue box appears in which you can choose whether to move the chart to an 
existing sheet, by selecting “Object in” and choosing the destination from the drop-
down list, or to a new sheet, by selecting “New sheet” and entering the sheet name in 
the corresponding text box.
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4 MICROSOFT POWERPOINT

Introduction

Microsoft PowerPoint is designed to present content visually. It should therefore 
be understood primarily as a graphic aid for oral presentations. This has clear 
implications for accessibility, since documents created in PowerPoint are not, strictly 
speaking, intended to communicate content on their own, but rather to support a 
spoken presentation and, in many cases, to capture the audience’s attention.

This guide provides recommendations and detailed steps for creating accessible 
presentations in Microsoft PowerPoint, to ensure that all individuals, regardless of 
their visual abilities, can access information equitably.

Using Built-in Slide Layouts

PowerPoint presentations are made up of pages called slides, to which different 
objects can be added, such as text in different styles, multimedia content, tables 
and charts. Unlike in Word, there is no stage at which a slide is treated as complete 
and a new blank one is created automatically. Instead, users add new slides to the 
presentation as they need them. When creating a new slide, they can either start 
with a blank slide and add the necessary objects themselves, or choose from a range 
of pre-designed slide layouts that already contain objects and can then be edited, 
removed or supplemented to suit the intended design.
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4 It is preferable to use PowerPoint’s built-in slide layouts rather than creating slides 
from scratch, as these layouts are optimised for accessibility. To include a pre-
designed slide:

1. Go to the Home tab.
2. Expand the New Slide button in the Slides group.
3. Select the type of slide to be inserted.

If you wish to change the layout of a slide that has already been inserted:

1. Go to the Home tab.
2. Expand the Layout button in the Slides group.
3. Select the new layout you wish to apply.
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4 Using Clear and Legible Fonts

In PowerPoint presentations, font size is not usually a problem, since PowerPoint uses 
larger fonts by default than Word does. As a general rule, font size should not be 
reduced below 24 points for titles or 18 points for body text.

As for colour, unlike in other Office applications there is no Automatic colour setting, 
so particular care should be taken to ensure sufficient contrast between the text and 
the background.

Finally, the same precaution applies to font choice: sans-serif fonts such as Arial, 
Tahoma or Verdana should be used.

To change these three characteristics (size, colour and type):

• Select a Text object on the slide.
• On the Home ribbon, within the Font group, you will find the Font, Size and

Font Colour buttons.
• Each of the three, once expanded, allows you to select the desired value.
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4 Adding Alt Text to Images

As explained above, PowerPoint is designed primarily for visual impact, so it makes 
extensive use of graphic content such as images, organisation charts, flow charts and 
graphs.

To ensure an acceptable level of accessibility, all such content must have alternative 
text. This text should be descriptive without being exhaustive, and should avoid 
unnecessarily long descriptions or irrelevant detail. Additionally, you should avoid 
indicating the type of object. That is, it is not necessary to include in the alt text 
expressions such as “Image of...” or “Photo of...”, since screen readers themselves 
usually indicate that a graphic object is being described (the exception is if what 
is being described is a screenshot, in which case it is appropriate to specify this, as 
shown in the example).

To add alt text to an image:

1. Select the image and right-click or press
the Applications key.

2. In the context menu, select View Alt Text.
3. In the Alt Text pane, enter a description in the

Description field.

Example: “Bar chart showing Trends in expenditure.” 

IMPORTANT

If the purpose of the image is to describe a process, 
a textual description should be provided on the slide 
itself, detailing the name and type of the objects 
shown in the image, as well as all the steps required to 
carry out the process using the keyboard.
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4 Setting the Reading Order

In a PowerPoint presentation, content is read aloud in the order in which it was 
created, not in the order in which it appears on screen, so this needs to be taken into 
account when creating the presentation. As noted at the beginning of this section, a 
good first step is to choose one of PowerPoint’s built-in slide layouts, as these already 
provide the correct reading order for the objects. In practice, however, it is often 
necessary to add new elements to slides after the presentation has been created, and 
this can affect the reading order. To correct the order of the objects (or simply verify 
that it is correct):

1. Go to the Home ribbon.
2. In the Drawing group, expand the Arrange button.
3. Select Selection Pane.
4. In the pane that opens, the list of objects on the active slide is displayed.
5. To change the order:

• With the mouse, drag each object to the correct position.
• With the keyboard, select the object and press Shift + Tab to locate the Bring

Forward button to move the object up, or Send Backward to move it down.
6. Make sure that the elements in the Selection Pane are in the correct reading order.
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4 IMPORTANT

The order in which they are displayed is the reverse of the order in which they will be 
read aloud; in other words, it will start reading from the last item and work its way up 
the list.

Furthermore, if the presentation is sent in auto-play mode (.ppsx), bear in mind that 
objects can be moved, appear and disappear with various visual and sound effects, 
and these characteristics apply to the objects on each slide and also to the transitions 
between slides.

Animations on slide objects should be avoided, as should automatic transitions 
between slides, since they may prevent the user from accessing all the content of 
each slide (due to lack of time).
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5 CREATING ACCESSIBLE PDFS FROM  
MICROSOFT APPLICATIONS

Introduction

PDF is a file exchange format used to distribute documents created on any 
platform, program or operating system. The key point is that regardless of the 
origin or destination of the file, its appearance will not change—it will retain 
graphics, formatting, typefaces, etc. Consequently, the ultimate goal is to preserve 
the appearance, and this is what the PDF-generating tools are designed to do. 
Furthermore, an interpreter program is needed to access them. The most commonly 
used program is Adobe’s Acrobat Reader.

To create a PDF, the usual approach is to start from a document created with 
a content-generating program. A PDF can be created from an image, a Word 
document, an Excel spreadsheet, a PowerPoint presentation, or documents created 
with advanced page layout programs (QuarkXPress, InDesign), etc.

Accessibility in PDFs

In terms of accessibility with screen readers, the most important aspect of the PDF 
format is tagging.

When a document is opened in this format, texts, images, etc. are visible, but 
internally all the PDF content is stored in tagged objects. Thus, a heading of any level 
will be tagged as <H1>, <H2>, etc. (depending on its level). Plain texts will be <P>, 
images <Figure>, and there are categories for almost any type of element in a text.

This tagging and its internal order is what provides the reader with the information 
needed to correctly read the content aloud.

In terms of visual accessibility, as in the rest of the sections of this course, the font 
type, size and colour should provide easy viewing and sufficient contrast between 
text and background.
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5 Creating accessible PDFs from Microsoft applications

As most users do not have professional PDF editing software, the following explains 
how to create accessible PDFs from Microsoft applications.

It may seem obvious, but the basic requirement for an accessible PDF is that the 
source document itself must already be accessible.

If a Word, Excel or PowerPoint file has been created using unsuitable fonts, poor 
contrast or untagged images, converting it to PDF will not correct any of those issues. 
In that sense, the essential requirement for accessibility is to ensure that the original 
document is accessible from the outset.

How to generate the PDF

Save as PDF

To save a file as PDF from Word, Excel or PowerPoint:

1. Go to File.
2. Select Save as Adobe PDF.
3. Select the name (by default it will be the same as

the source file) and the location where the file will
be saved.

4. Click Options (the different processes depending
on the type of source file will be detailed in the
following sections).

5. Click Save.



Creating accessible documentation

41

5 Options in Microsoft Word

Once the Options button has been clicked in the Save as PDF dialogue box in 
Microsoft Word, a dialogue box is displayed that allows you to configure the 
characteristics of the PDF that will be generated from the Word source.

The options that must be ticked are:

• Enable Accessibility and Reflow with tagged Adobe PDF. As previously
explained, the PDF arranges its content in a tag structure that the screen reader
accesses to correctly interpret the objects and the reading order. By ticking this
option, all the information of this type that is also stored in Word is “translated”
into the PDF tag language.

• Create Bookmarks and Convert Word Headings to Bookmarks. This option
activates the possibility of creating a PDF-specific index using the heading
structure (see above, in the Word section, where we discussed assigning the
Heading 1, Heading 2, etc. styles to generate the table of contents. Adobe does
something similar in its PDFs.)

• The remaining options are not necessary.

In this same dialogue box, there 
is the option of filtering which 
part of the document is to be 
converted (All, the current page 
—i.e., the page on which the cursor 
was located when the menu was 
accessed—or a specific range of 
pages).

Once you have verified that the 
desired options are ticked, click OK 
to return to the dialogue Box Save 
as PDF dialogue box (described 
above) and click Save.
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5 Options in Microsoft Excel

When you click Save as Adobe PDF in an Excel workbook, the first thing displayed is 
a dialogue box that allows you to select which parts of the workbook to convert (the 
entire workbook, a previously selected range of cells, or specific sheets).

Additionally, you can define how the content fits on the page (these are similar 
options to those that need to be set when printing in Excel).

Once these parameters have been defined, click Convert to PDF to access the  
Save As dialogue box.

In that dialogue box, click Options, and in the dialogue box that opens, verify that 
the Enable Accessibility and Reflow with tagged Adobe PDF and Create Bookmarks 
options are ticked (which, unlike in Word, does not present further options).

Once these options are ticked, click OK to return to the save dialogue box to 
complete the process. 
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5 Options in Microsoft PowerPoint

For PowerPoint, the conversion options that should be ticked are:

• Enable Accessibility and Reflow with tagged Adobe PDF.
• Create Bookmarks.
• Convert Multimedia. Ticking this checkbox means that multimedia objects will be

retained in the PDF, for example a video. If it is unticked, in that same example, the
video will be replaced by a still image of its first frame.

Additionally, you can select whether to convert the entire presentation, the slide that 
had focus when Save as Adobe PDF was accessed, or just a specific slide.

Once the conversion has been configured, click OK to return to the Save as PDF 
dialogue box to complete the conversion process.
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6 THE ACCESSIBILITY ASSISTANT 
IN MICROSOFT OFFICE

Introduction

The Accessibility Assistant is a tool built into Office 365 that is available in Word, 
Excel, Outlook, OneNote and PowerPoint.

It performs three functions: finding accessibility issues, explaining why each of the 
detected issues could be a problem for people with disabilities, and providing 
guidance on how to fix each issue.

VERY IMPORTANT

This automatic review process cannot detect all issues. Furthermore, some of the 
issues the Accessibility Assistant might flag will not necessarily be errors that need to 
be fixed.

The Accessibility Assistant has certain limitations. For example, it cannot detect 
whether information is conveyed solely through colour, assess whether alternative 
text is appropriate, or check whether a video includes subtitles. In some cases, it may 
even miss errors that can be identified manually, such as insufficient contrast in font 
colours.

For this reason, a manual review of the file is also essential to ensure that all the 
guidance given throughout this course has been applied correctly.

Accessing the Accessibility Assistant

Once you have finished creating the content in the Microsoft Office application 
(a Word document, an Excel workbook, a PowerPoint presentation or an Outlook 
message), it is time to use the Assistant to carry out an initial accessibility review that 
can alert you to any issues that need to be addressed.
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6 To access the Assistant:

1. Go to the Review ribbon.
2. Click the Check Accessibility button.
3. A pane opens showing the detected errors.

This pane is organised into buttons that  
group each type of detected error. Clicking 
the button in the pane displays details of the 
issue, explains its consequences and, in 
many cases, allows it to be fixed directly—for 
example by adding alt text to images, 
changing the appearance of a table or 
modifying the font colour. For each type of 
issue, you can also move through all the 
instances found in the document.

NOTE

This guide was produced using the Office 
Microsoft 365 MSO version (version 2506 
build 16.0.18925.20216) 64-bit and Adobe 
Acrobat version 2025.001.20467 64-bit.
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